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Welcome to 2017 Knowledge-Based Examinations of Service Organizations for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2017 release of Knowledge Based Examinations of Service
Organizations. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998.
Additional information is available on CCH Support Online.

New in this Release

Knowledge-Based Examinations of Service Organizations is designed to help the practitioner efficiently and effectively conduct
examination engagements of service organizations in accordance with applicable standards issued by the American Institute of Certified
Public Accountants (AICPA). The knowledge-based methodology for service organization engagements is a risk-based methodology for
conducting examination engagements of service organizations. It emphasizes using knowledge of the entity, subject matter, and criteria
to make the risk assessments and recommendations in connection with an engagement. The more accurately a practitioner assesses
risks of material misstatement or deviation, the more assurance the practitioner has that the procedures performed in response to the
risk assessments will detect material misstatements or deviations.

The Knowledge-Based Examinations of Service Organizations covers SOC 1, SOC 2, and SOC 3 engagements.

The forms and practice aids in the knowledge-based methodology will help the practitioner to perform the procedures necessary to
complete the engagement in accordance with professional standards. The Knowledge-Based tools include documents, attestation
programs, practice aids, correspondence, and example reports.

Although the KBA approach provides a framework for applying attestation standards, it is not a substitute for knowledge of professional
standards and the exercise of the practitioner’s professional judgment and professional skepticism. The practitioner may need to refer
to additional resources to determine how to apply the applicable standards to unfamiliar or unique circumstances.

The 2017 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2017 Knowledge-Based Examinations of Service Organizations content has been migrated from the 2016 Non-Traditional
Engagements title and enhanced here to expand the coverage. At this time, there is no conversion or automatic migration of any
answers provided in the 2016 Non-Traditional Engagements title over to the new 2017 Knowledge-Based Examinations of Service
Organizations title, because the content has changed quite markedly due to standard updates and to its migration into a standalone
title.

The 2017 edition of Knowledge-Based Examination of Service Organizations features numerous enhancements from the previous
content, including:

¢ KBA-103 was not included and all flow of “Control Deficiency” findings will flow to KBA-101 since an evaluation of control
deficiencies are not required by the standards.

¢ ATT-114 and ATT-115 from the Non-Traditional Examination Title were updated to remove outdated steps and practice alerts
and also to modify and add steps and practice alerts to reflect current accounting authoritative literature.

¢ Anew section has been added to AID-201 to address “Threats and Safeguards” regarding auditor independence.

¢ Many new documents in this title as follows:
o ATT-403 Evaluation of Management's Description of the Service Organizations System
o ATT-901 Attestation Program: Subsequent Events
o COR-916 Representation Letter: Type 1 Engagement to Report on Controls at a Service Organization Relevant to
Security, Availability, Processing Integrity, Confidentiality, and Privacy (SOC 2)


http://support.cch.com/productsupport/

o RPT-1010A Service Auditor’s Engagement (SOC 1): Unmodified Opinion on a Description of a Service Organization’s
System and the Suitability of the Design of Controls (Type 1)

o RPT-1010B Service Auditor's Engagement (SOC 1): Unmodified Opinion on a Description of a Service Organization’s
System and the Suitability of the Design of Controls (Type 1)

o RES-018 Determination of the Relevancy of Controls to Internal Control Over Financial Reporting

Click here for the 2017 Examination of Service Organizations Title Overview for Knowledge Coach Users

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:

¢

AICPA Auditing Standards Board (ASB) Statements on Standards for Attestation Engagements (SSAEs), Attestation Standards:
Clarification and Recodification (SSAE No. 18);

AICPA Audit and Accounting Guide, Service Organizations: Applying SSAE No. 16, Reporting on Controls at a Service
Organization Relevant to User Entities’ Internal Control Over Financial Reporting (SOC 1)

AICPA Audit and Accounting Guide, Reporting on Controls at a Service Organization Relevant to Security, Availability,
Processing Integrity, Confidentiality, or Privacy (SOC 2)

TSP section 100, Trust Services Principles, Criteria, and Illustrations for Security, Availability, Processing Integrity,
Confidentiality, and Privacy

2011 Revision of Government Auditing Standards (GAGAS, or the Yellow Book; QC Section 10, A Firm's System of Quality
Control; and

AICPA Code of Professional Conduct (Code), including the provisions of ET Section 1.295, Nonattest Services

Important Notes

¢
¢

Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
As of the December 2016 update to Engagement 7.5 and Knowledge Coach 2.5 (7.5.100.1220), you can open binders that

contain Knowledge Coach workpapers when logged into the Shared File Room (SFR) mode in Engagement with the following
restrictions:

o Knowledge Coach workpapers cannot be edited in the SFR mode.

o However, Knowledge Coach workpapers can be viewed as read-only, signed off on, and workpaper notes can be
written on Knowledge Coach workpapers while in the SFR mode.

o Non-Knowledge Coach workpapers can be edited in SFR mode without restriction.

System Requirements

¢

This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5
(7.5.100.1192 or higher), and 2016 Financial Statement Base v3 or higher. If you have not installed the ProSystem fx®
Engagement 7.5 and Knowledge 2.5 (7.5.100.1192 or higher), ensure that you do so before using this title. If you are upgrading
from ProSystem fx® Engagement 7.1 or lower please contact Technical Support at 1-800-PFX-9998 for detailed instructions.

A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Check License

The license for Knowledge-Based Examinations of Service Organizations is called “Knowledge-Based SOC Engagement” in the CCH
ProSystem fx Admin module. As of the December 2016 update to Engagement/Knowledge Coach (7.5.100.1220 or higher), Knowledge-
Based SOC Engagement has been added to the available licenses. If you have not run this update or to verify, please check the CCH


http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2017%20Service%20Organizations%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf

ProSystem fx Admin module to confirm the SOC license is present by performing the following steps and if not please follow the
instructions under “Download Instructions” to run the License Update Utility.

1. Open the CCH ProSystem fx Admin Module
2. Under “Staff”, choose Assign License
3. Verify "Knowledge-Based SOC Engagement” license is listed as an available license

Download Instructions

If you have not run the CCH ProSystem fx Engagement 7.5 and Knowledge Coach 2.5 December 2016 Update or the Knowledge-Based
SOC engagement license isn't listed, you must run the License Update Utility BEFORE adding the 2017 Knowledge-Based Examination
of Service Organizations to Engagement version 7.5 by performing the following steps:

1. Download the License Update Utility and Engagement Version 7.5 License Update File from this site.
Right click on PfxEngUpdateUtility and Run as administrator

Log in to the utility using your Admin login

Browse to LicenseUpdate7.5_20161102.upd that was downloaded along with the utility

Click “OK” to run the update

You will receive a message when the update is complete

7. Open the ProSystem fx Engagement Admin application and assign licenses to your staff
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Download the 2017 Knowledge Based Examination of Service Organizations from the ProSystem fx ®Knowledge Coach Updates section
of the ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then
select the Knowledge Coach Series and Download file link next to the 2017 Knowledge-Based Examination of Service Organizations. On
some occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the
extension of the downloaded file to KCP using all capital letters.

You must install the 2016 Financial Statement Base v3 title before installing the 2017 Knowledge Based Examination of Service
Organizations.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2017 Knowledge-Based Examination of Service Organizations (2/23/17).KCP download is a proprietary file that must be installed
from within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in the
Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2017 Knowledge Based Examination of Service Organizations, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.


https://support.cch.com/updates/Engagement/#engagementLicenseFiles
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¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2017 Knowledge-Based Examination of Service Organizations title has been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2017
Knowledge-Based Examination of Service Organizations.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Accounting Research Manager

CCH'’s Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Soon to be available on ARM, the Knowledge-Based Examination of Service Organizations Guide helps you comply with the most recent
professional standards and guidance for the conduct of examinations of Service Organizations and to integrate the use of practice aids,
tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are
available in Knowledge Coach.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a binder in ProSystem fx® Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select New Knowledge Coach Workpaper from the toolbar or File menu. The New
Knowledge Coach Workpaper dialog appears (Figure 1).

Select the New Knowledge Coach Title with the content you would like to use. You can only select titles you have installed. The
information displayed changes to reflect the workpaper organization available for the selected title.

Select the Knowledge Coach Workpaper Templates to insert into your binder and click OK. The Selected Workpaper Properties dialog
appears. Each workpaper name is automatically loaded into the Name field. Add a workpaper index in the Index field and make any
Name modifications you desire. You can also modify the tab location or the roll forward settings for each workpaper. Then click OK.

The integrated Knowledge Coach workpaper is now inserted into your engagement binder. For more information on how to use
Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.
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Figure 1- New Knowledge Coach Workpaper

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Methodology for Nontraditional Engagements- Allows the results of one set of procedures to become the input for
the next. The key components of the KBA methodology include:

¢
¢

* & o o

An Overview that guides practitioners through the methodology;

Knowledge-Based Attestation documents, integral to the risk assessment and overall attestation processes, which contain steps
and procedures required by professional standards;

Customizable Engagement Programs that take practitioners through related steps and procedures;
Practice Aids to help practitioners complete steps or processes outlined in the overall engagement programs;
Practitioner’s Reports that provide a variety of sample practitioner’s opinions on nontraditional engagements; and

Correspondence documents that provide sample engagement and representation letters to be used to comply with professional
standards, SSAE and SSCS requirements, and in many other common situations.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows practitioners to use the Knowledge-Based-Audit methodology more
efficiently by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each particular
engagement, and documenting the link between risks identified and procedures performed. ATT-100 Tailoring Question
Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the



engagement documentation to fit each client. Completing the questions helps the practitioner avoid duplication and
unnecessary workpapers.

¢ Before you begin your engagement, please review the guidance in ATT-101 Overall Audit Program, ATT-114 and ATT-115. These
workpapers are intended to be your road map through a Knowledge-Based methodology. You should start your audit with ATT-
100 Tailoring Question Workpaper and ATT-101 Overall Audit Program.

¢ Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-501
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers
prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All
documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper
identified in” field of the Risk pane.

¢ Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

¢ Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

¢ Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes attestation content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA.

¢ Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help practitioners work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.

Download 2017 Knowledge-Based Examinations of Service
Description: Organizations(2/23/2017)

Engagement v. 7.5 with Knowledge Coach 2.5 or higher and

Version: 2016 Financial Statement Base v3
Release Date: February 2017
File size: 18MB

Approx. Download |5 i o6 at 56 kbps

Time:

License: Full Version

Platforms: Windows® 7, 8, 8.1, 10

Office: Microsoft® Office 2010 or higher required

Contact Information

¢ For ademo or to purchase additional titles as they become available ~1-800-PFX-9998

¢ Technical Support 1-800-PFX-9998

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this



product. For information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.



